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Experiment HP-6: Visual Evoked Potentials (VEP)

Background
The Visual Evoked Potential test (VEP) examines the function of the visual pathway from the retina to 
the occipital cortex of the brain by measuring the conduction of the visual pathways from the optic 
nerve to the visual cortex. A VEP is a response that is caused by a visual stimulus, such as an 
alternating checkerboard pattern on a computer screen. Responses are recorded from electrodes that are
placed on the head and are observed as a graph on a computer. These responses usually originate from 
the occipital cortex (near the back of the head) which is the area of the brain involved in receiving and 
interpreting visual signals as they come in from the eye. VEP tests measure the time that it takes for a 
visual stimulus to travel from the eye to the occipital cortex of the brain. It can show whether the nerve 
pathways are abnormal in any way. 

VEP tests are normally performed when an individual is experiencing changes in vision that can be 
caused by problems along the pathways of certain nerves. Some of these symptoms may include: loss 
of vision; double vision; blurred vision; and seeing flashing lights. Many times, these vision changes 
are not easily detected on clinical examination or they occur in young children who cannot respond 
verbally to visual tests or are unable to read eye charts. In general, a VEP test is useful for detecting 
optic nerve problems. The optic nerve is the nerve that transfers signals from the retina to the brain to 
allow us to see. Testing the nerve shows how the visual system responds to light. 

The usual wave pattern is an initial negative peak (N1 - Latency), followed by a large positive peak (P1
- Evoked Potential), followed by another negative peak (N2). The normal maximum value for P100 is 
approximately 115 msec in individuals younger than 60 years; after this age, it rises to about 120 msec 
in women and 125 msec in men. 

Clinical Uses
Clinical uses of the VEP test include diagnostics for:

• Optic neuropathy

• Diabetes Toxic

• Tumors compressing the optic nerve - Optic nerve gliomas, meningiomas, 
craniopharyngiomas, giant aneurysms, and pituitary tumors 

• Multiple Sclerosis.

• There are many reasons that VEP testing is used for clinical diagnostics including: 

• it is an objective and reproducible test for optic nerve function in adults and children;

• it is more sensitive than MRI or physical examination for prechiasmatic lesions;

• it is inexpensive.
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Testing Parameters
Testing should follow certain procedures:

• the subject should sit between 70-100 cm from the computer monitor;

• any corrective lenses should be worn by the subject so that any vision problems are not a factor 
during the test;

• each recorded section of data should be about 10 seconds in length;

• 10-20 responses will be averaged to get the best results.

Performing the VEP Test
The VEP test is very easy to perform. Students will use the iWorx data acquisition unit and EEG lead 
wires attached to the scalp of the subject. This test can be completed using just three leads, but five 
leads can be used if desired. The subject will watch a series of flashing lights and images while testing 
each eye individually and results will be measured by the length of time it took the brain to respond to 
the stimuli. 
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Experiment HP-6: Visual Evoked Potentials (VEP)

Equipment Required
PC or Mac Computer - preferably 2 per station

USB cable

IX-B3G USB recorder 

Three EEG leads

EEG Electrodes (3)

Elastic headband

Alcohol swabs

IX-B3G Setup
Use the USB cable to connect the computer to the USB port on the IX-B3G. 

Start the Software
1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 
the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 
will appear as the program opens. There will be a message indicating that LabScriber has 
recognized the IX-B3G.

2. On the Main window, pull down the Settings menu and select Load Group and open the 
Settings folder.

3. Select the IXB3G.iwxgrp settings group and click Open.

4. Pull down the Settings menu again. Select the VisualEvokedPotentials settings file from Human
Psychophysiology.

5. After a short time, LabScribe will appear on the computer screen as configured by the 
VisualEvokedPotentials settings.

6. For your information, the settings used to configure the LabScribe software and the IX-B3G 
unit for this experiment are programmed on the Preferences Dialog window which can be 
viewed by selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 
of the following documents:

• Appendix
• Background
• Labs
• Setup (opens automatically)
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EEG Electrodes Setup
1. Connect the EEG electrodes to the IX-B3G (Figure HP-  6  -S1). If using three electrodes, connect

the red, black, and green leads to the matching color-coded connectors. If using five electrodes, 
also connect the white and brown leads. 

Figure HP-6-S1: The IX-B3G with three snap leads and electrodes connected.

2. Select one person from your group to be the subject in this experiment.

3. Use alcohol swabs to clean the skin where the electrodes will be placed. Three electrodes will 
be placed on the head:

• one is high on the forehead, slightly to the left or right of the centerline.

• one is located just at the edge of the eyebrow, between the eyebrow and the hairline.

• one is on the occipital area, about two inches above the nape of the neck.

• Place an elastic headband around the subject’s head to hold the electrodes in place. The 
headband should be placed as high over the ear as possible. The headband should be 
tight enough so that it does not slide up or down, but not so tight that it is uncomfortable.

4. Reusable gold cup EEG electrode buttons can also be used instead of the snap electrodes. If 
these are used:

• Place a dab of the tacky conductive gel on each recording electrode before it is placed on
the proper location.

• Place each recording electrode in the proper location (Figure HP-6-S2).

5. Once the electrodes are in place, attach the three electrode lead wires to the ground and 
Channels 1 and 2 inputs on the lead pedestal of the iWire-B3G EEG cable. 

• The lead from the electrode on the back of the head at the occipital cortex is connected 

Human Psychophysiology – VisualEvokedPotentials HP-6-4



iW
or

x S
am

ple
 La

b

to the red or +1 input.

• The lead from the electrode near the center of the forehead is connected to the black or 
-1 input

• The lead from the electrode next to the eyebrow is connected to the green (ground) or C 
input.

6. If disposable electrodes are used in the recording setup:

• The electrodes need to have as little hair as possible under their centers. 

• Trim the electrodes to make them a bit smaller prior to removing the plastic protective 
covering. Apply the electrodes to the proper locations.

• Once the electrodes are in place, attach the color-coded lead wires between the 
electrodes and the inputs on the IX-B3G in accordance to Figure HP-6-S2.

7. The lead wire for the electrodes should not hang down in the person’s eyes. Drape it loosely 
over the top of the subject’s head. This lead can be secured under a headband.

8. The subject should sit quietly with their hands in their lap watching a computer monitor 
showing the images for VEP testing.

Figure HP-6-S2: The positions of the electrodes used to record the VEP from a subject.
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Experiment HP-6: Visual Evoked Potentials (VEP)

Exercise 1: Recording the Subject with Eyes Closed
Aim: To learn how to record from the subject while the eyes are closed.

Procedure
1. Ask the subject to sit quietly and not move unless told to do so, and to keep his or her eyes 

closed during this phase of the experiment. 

2. Click on the Record button, located on the upper right side of the LabScribe Main window 
(Figure HP-6-L1). The signal should begin scrolling across the screen.

Note: If the user clicks the Record button and there is no communication between the iWorx unit and 
computer, an error window will appear in the center of the Main window. Make sure the IX-B3G is 
connected to the USB port of the computer. Click OK and select the Find Hardware function from the 
LabScribe Tools menu. 

3. Type the <Subject’s Name>-Eyes Closed in the Mark box to the right of the Mark button. Press 
the Mark button or the Enter key on the keyboard to attach the comment to the data. Continue 
recording for approximately ten seconds.

4. Click Stop to halt recording.

5. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 
in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click 
on the Save button to save the data file.

Exercise 2: VEP Testing Patterns 
Aim: To identify the VEP pattern for the left eye while looking at a flashing checkerboard.

Procedure
1. Instruct the subject that he or she needs to avoid any movement other than opening his or her 

eyes when asked. The subject should have his or her eyes closed at the beginning of the 
recording.

2. Have the subject cover his or her right eye with their hand or a patch of some type.

3. Click Record, and then click the AutoScale button on the VEP Response channel. You should 
observe a recording similar to the “eyes closed” recording shown in Figure HP-6-L1.

4. Type the letter C for Eyes Closed in the Mark box to the right of the Mark button. Press the 
Mark button or the Enter key on the keyboard to mark the recording. Record for five seconds.

Human Psychophysiology – VisualEvokedPotentials HP-6-6
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5. While the subject has his or her eyes closed, type the Left Eye Checkerboard in the Mark box. 
Press the Mark button or the Enter key on the keyboard to mark the recording as you instruct 
the subject to open his or her eyes and focus on the dot in the center of the flashing 
checkerboard pattern. Record the subject’s VEP pattern for ten seconds.

Figure HP-6-L1: Recording shown of subject sitting quietly with his or her eyes closed during the 
initial section of the VEP test.

Note: At this time, set up the second computer with the flashing checkerboard pattern video ready to be
shown to the subject. One video that can be used is: http:// www.youtube.com/watch?v=xEd1h_lz4rA 

Note: It is important that the video is ready to play immediately as the subject opens his or her eyes. 

6. Click Stop to halt recording.

7. Select Save in the File menu.

8. Have the subject close their eyes and sit quietly for about 10 seconds.

9. Repeat this procedure 10-20 times for the subject’s left eye, stopping after each 10 second 
recording.

Human Psychophysiology – VisualEvokedPotentials HP-6-7
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1. Scroll through the data recorded in this exercise and find the first VEP pattern for the subject’s 

left eye and checkerboard pattern.

2. Use the Display Time icons in the LabScribe toolbar (Figure HP-6-L2) to adjust the Display 
Time of the Main window to show the ten second section of data on the Main window. This 
section of data can also be selected by:

• Placing the cursors on either side of the data recorded while the subject’s eyes were 
open.

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the 
period to the width of the Main window.

3. Scroll through the data recorded in this exercise and find a artifact-free section of data recorded 
while the subject’s eyes were open.

4. Use the Display Time icons in the LabScribe toolbar (Figure HP-6-L2) to adjust the Display 
Time of the Main window to show a ten second artifact-free section of data on the Main 
window. This section of data can also be selected by:

• Placing the cursors on either side of the data recorded while the subject’s eyes were 
open.

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the 
period to the width of the Main window.

Figure HP-6-L2: The LabScribe toolbar.

5. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 
transfer the data displayed in the Main window to the Analysis window (Figure HP-6-L3).

6. Look at the Function Table that is above the uppermost channel displayed in the Analysis 
window. The name of the mathematical function used in the analysis, T2-T1, appears in this 
table. The values for T2-T1 is seen in the table across the top margin of the VEP Response 
channel.

Human Psychophysiology – VisualEvokedPotentials HP-6-8
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7. Once the cursors are placed in the correct positions for determining the time difference between 
the Latency and Evoked Potentials in the ten-second section of data, the values of these 
parameters can be recorded in the on-line notebook of LabScribe by typing their names and 
values directly into the Journal, and on Table HP-6-L1.

8. The functions in the channel pull-down menus of the Analysis window can also be used to enter
the names and values of the means into the Journal. To use these functions:

• Place the cursors at the locations used to measure the values for the parameters of the 
VEP pattern in the selected region of data.

• Transfer the name of the mathematical function used to determine the values of the 
parameters to the Journal using the Add Title to Journal function in the pull-down menu 
of any channel.

9. Transfer the values of the parameters of the VEP pattern to the Journal using the Add Ch. Data 
to Journal function in the VEP Response Channel pull-down menu.

Figure HP-6-L3: Recording of VEP patterns from the subject’s left and right eyes as shown on the 
Main window. 

Human Psychophysiology – VisualEvokedPotentials HP-6-9
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Figure HP-6-L4: Recording of a single VEP response displayed in the Analysis window showing the 
placement positions of the cursors.

Note – if the recording appears upside-down, click the Invert button using the down arrow to the left of 
the VEP Response channel.

10. See Figure HP-6-L4 for a labeled diagram showing the positions of the cursors:

• Place 1 cursor on your recording at the area shown by the red dot and the second at the 
position of the purple dot to measure the T2-T1 value for Latency.

• Leave the right-hand cursor at the purple dot and move the left-hand cursor to the 
position of the green dot to measure T2-T1 for the Evoked Potential response (Figure 
HP-6-L5).

11. Return to the Main window. Scroll through the recording and find the second recording of the 
VEP of the left eye while observing the flashing checkerboard.

12. Repeat these steps for the rest of the trials while observing the flashing checkerboard with the 
left eye. Find the values for T2-T1 for Latency and Evoked Potential and enter this data into the
Journal and on Table HP-6-L1 as performed previously.

13. Select Save in the File menu.
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Figure HP-6-L5: The VEP response shown in the analysis window showing the T2-T1 value for the 
evoked response.

Questions
1. Do each of the ten responses have the same latency? Evoked Potential?

2. Why or Why not?

3. Explain what is happening physiologically during the latent period.

4. What is actually occurring during the Evoked Potential?

Human Psychophysiology – VisualEvokedPotentials HP-6-11
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Table HP-6-L1: Checkerboard - VEP Latency Period and Response Time for the Left Eye 

Trial Number

VEP RESPONSE TIME - Checkerboard

Left Eye

Latency (sec) Evoked Potential (sec)

1

2

3

4

5

6

7

8

9

10

MEAN

Human Psychophysiology – VisualEvokedPotentials HP-6-12
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Table HP-6-L2: Checkerboard - VEP Latency Period and Response Time for the Right Eye 

Trial Number

VEP RESPONSE TIME - Checkerboard

Right Eye

Latency (sec) Evoked Potential (sec)

1

2

3

4

5

6

7

8

9

10

MEAN
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Exercise 3: VEP Testing using the Checkerboard Pattern 
Aim: To identify the VEP pattern for the right eye while looking at a flashing checkerboard.

Procedure and Data Analysis
1. Repeat the procedure for both recording experimental data and data analysis as shown in 

Exercise 2.

2. Enter the data in the Journal and on Data Table HP-6-L2.

Exercise 4: VEP Testing using the Moving Dartboard Pattern
Aim: To identify the VEP pattern for the both the left and right eyes while looking at a rotating 
dartboard pattern.

Note: Use the link: http://www.youtube.com/watch?v=GYIIw0vGDk4 for the rotating dartboard 
pattern for VEP testing.

Procedure and Data Analysis
1. Repeat the procedure for both recording experimental data and data analysis as shown in 

Exercise 2. Make sure to do both eyes independently.

2. Enter the data in the Journal and on the two data tables: Table     HP-6-L3 and Table HP-6-L4.

Questions
1. Is there a difference in the Latency period for the left eye between the checkerboard pattern and 

the dartboard pattern? 

2. Is there a difference in the Latency period with the right eye between the two patterns?

3. Is there a difference in the T2-T1 value Evoked Potential for the right and left eyes between the 
checkerboard and dartboard patterns?

Human Psychophysiology – VisualEvokedPotentials HP-6-14
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Table HP-6-L3: Dartboard - VEP Latency Period and Response Time for the Left Eye

Trial Number

VEP RESPONSE TIME - Dartboard

Left Eye

Latency (sec) Evoked Potential (sec)

1

2

3

4

5

6

7

8

9

10

MEAN
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Table HP-6-L4: Dartboard - VEP Latency Period and Response Time for the Right Eye

Trial Number

VEP RESPONSE TIME - Dartboard

Right Eye

Latency (sec) Evoked Potential (sec)

1

2

3

4

5

6

7

8

9

10

MEAN
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